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INTRODUCTION 

This User Guide presents the basic concepts of SmartDraw to help New Users get started in creating 

sophisticated, professional Diagrams. 

 

To get sǘŀǊǘŜŘ ƛƴ {ƳŀǊǘ5ǊŀǿΣ ǿŜΩƭƭ ōŜ ǇǊƻǾƛŘƛƴƎ ȅƻǳ ǿƛǘƘ ŀƴ ƻǾŜǊǾƛŜǿ ƻŦ ƴƻǘ ƻƴƭȅ ǘƘŜ ŦŜŀǘǳǊŜǎ ŀƴŘ 

ŦǳƴŎǘƛƻƴŀƭƛǘȅ ōǳǘ ƻǳǊ ǇǊƻǾŜƴ ōŜǎǘ ǇǊŀŎǘƛŎŜǎΦ  ²ŜΩƭƭ ŎƻǾŜǊ Ƙƻǿ ǘƻ select the right Template and give you a 

tour of the user interface, also known as the UI.  Knowing how the tool is designed will give you added 

insight that will enable you to maximize all that SmartDraw has to offer.   

 

WŜΩƭƭ ƳƻǾŜ ƻƴ ǘƻ ǎƻƳŜ ƻŦ ǘƘŜ Řŀȅ-to-day features like saving, opening, and closing a recent Diagram.  

¢ƘŜƴ ǿŜΩƭƭ ŎƻǾŜǊ Ƙƻǿ ǘƻ ŎǊŜŀǘŜ ŀƴŘ ŘŜǎƛƎƴ ȅƻǳǊ Diagrams by adding text, color, and effects as well as 

editing and formatting.  

 

Lastly, what good is a Diagram ƛŦ ȅƻǳΩǊŜ ǳƴŀōƭŜ ǘƻ ǎƘŀǊŜ ƛǘΚ ²ŜΩƭƭ Ǝƻ ƻǾŜǊ ǘƘŜ ƴǳƳōŜǊ ƻŦ ǿŀȅǎ ǘƻ export, 

share, and print your Diagrams.   

 

Throughout this User GuideΣ ȅƻǳΩƭƭ ōŜ ƛƴǘǊƻŘǳŎŜŘ ǘƻ ƴŜǿ ǘŜǊƳƛƴƻƭƻƎȅ ǳƴƛǉǳŜ ǘƻ {ƳŀǊǘ5ǊŀǿΦ  Lǘ ǿƻǳƭŘ ōŜ 

beneficial for you to begin to learn these terms as it will enable you to easily search the Help feature as 

well as our website.  And if yoǳ ǎƘƻǳƭŘ ŘŜŎƛŘŜ ǘƻ Ŏŀƭƭ ƛƴ ŦƻǊ ŀǎǎƛǎǘŀƴŎŜ ŦǊƻƳ ƻǳǊ ǘŜŀƳ ƻŦ ŜȄǇŜǊǘǎΣ ǘƘŜȅΩƭƭ 

ǳƴŘŜǊǎǘŀƴŘ ŜȄŀŎǘƭȅ ǿƘŀǘ ȅƻǳΩǊŜ ǊŜŦŜǊǊƛƴƎ ǘƻΦ    

 

LǘΩǎ ƛƳǇƻǊǘŀƴǘ ǘƻ ƴƻǘŜ ǘƘŀǘ ǘƘŜ ŦŜŀǘǳǊŜǎ ŀƴŘ ŦǳƴŎǘƛƻƴŀƭƛǘȅ ŎƻǾŜǊŜŘ ƛƴ ǘƘƛǎ ¦ǎŜǊ DǳƛŘŜ Ŏŀƴ ōŜ ŀǇǇƭƛŜŘ ǘƻ ŀƭƭ 

of the Templates available in SmartDraw.  With a strong ǳƴŘŜǊǎǘŀƴŘƛƴƎ ƻŦ ǘƘŜǎŜ ŦǳƴŘŀƳŜƴǘŀƭǎΣ ȅƻǳΩƭƭ ōŜ 

able to maximize every SmartDraw tool to communicate visually and effectively.   
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GETTING STARTED IN SMARTDRAW 

HOME SCREEN 

 

We begin with two main areas.  To the right ȅƻǳΩƭƭ ŦƛƴŘ ǘƘŜ ¢ŜƳǇƭŀǘŜ tǊŜǾƛŜǿ !ǊŜŀ ǘƘŀǘ Ŧƛƭƭǎ Ƴƻǎǘ ƻŦ ǘƘŜ 

ǊŜŀƭ ŜǎǘŀǘŜ ƻŦ ȅƻǳǊ ǎŎǊŜŜƴΦ ¢Ƙƛǎ ƛǎ ǿƘŜǊŜ ȅƻǳΩƭƭ ōŜ ŀōƭŜ ŀŎŎŜǎǎ ǘƻ ƻǾŜǊ тл /ŀǘŜƎƻǊƛŜǎ ƻŦ 5ƛŀƎǊŀƳǎΦ Lƴ ǘƘŜ 

[ŜŦǘ tŀƴŜƭ ȅƻǳΩƭƭ ǎŜŜ тл /ŀǘŜƎƻǊƛŜǎ ǘƘŀǘ Ŏƻƴǘŀƛƴ ƳƻǊŜ ǘƘŀƴ улл ¢ŜƳǇƭŀǘŜǎΦ .ȅ ƭŜǾŜǊŀƎƛƴƎ an existing 

¢ŜƳǇƭŀǘŜΣ ȅƻǳΩƭƭ ǎŀǾŜ ȅƻǳ ǘƛƳŜ ŦǊƻƳ ƘŀǾƛƴƎ ǘƻ ǎǘŀǊǘ ŦǊƻƳ ǎŎǊŀǘŎƘΦ hǊ ƛŦ ȅƻǳ ŀǊŜ ƻƴŜ ǿƘƻ ƴŜŜŘǎ 

inspiration or ideas to get the creative juices flowing this is a great place for you to explore what 

SmartDraw has to offer. The possibilities of what you create in SmartDraw are endless.  If you prefer a 

more direct approach, you can easily utilize the Search functionality.   

 

 

 

Figure 1. Home Screen gives you access to 70 Categories of Diagrams to choose from 
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HOW TO SEARCH FOR A TEMPLATE OR AN EXISTING DIAGRAM 

Step Action 

1 Navigate to the top of the Home Screen. 

2 Enter the appropriate criteria in the Search Box. Click Search or magnifying glass. 

 

Note: You may also use the Enter key to execute the search.  

 

The results field will display the total number of items found.  Use the previous and next results controls 

to navigate from one to the next. 

 

 

 

Figure 2. Quickly locate Templates or Diagrams ȅƻǳΩǾŜ ŎǊŜŀǘŜŘ ǳǎƛƴƎ ǘƘŜ {ŜŀǊŎƘ ŦŜŀǘǳǊŜ 
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SELECTING THE RIGHT SMARTDRAW TEMPLATE 

.ŜŦƻǊŜ ȅƻǳ ōŜƎƛƴ ŀƴȅ ǘŀǎƪ ƻǊ ǇǊƻƧŜŎǘΣ ƛǘΩǎ ƛƳǇƻǊǘŀƴǘ ǘƻ ǎǘŀǊǘ ǿƛǘƘ ǘƘŜ ǊƛƎƘǘ ǘƻƻƭǎΦ  Lƴ ǘƘƛǎ ŎŀǎŜΣ ȅƻǳΩƭƭ ǿŀƴǘ 

ǘƻ ǎǘŀǊǘ ǿƛǘƘ ǘƘŜ άǊƛƎƘǘέ Template.   As New Users, it will probably take some time for you to determine 

which Templateǎ ȅƻǳΩƭƭ ǳǎŜ ƻƴ ŀ Řŀƛƭȅ ōŀǎƛǎ ŀƴŘ ǘƘƻǎŜ ǘƘŀǘ ȅƻǳΩƭƭ ŦƛƴŘ ƘŜƭǇŦǳƭ ƻƴ ƻŎŎŀǎƛƻƴΦ   

¦ƴǘƛƭ ǘƘŜƴΣ ƘŜǊŜ ŀǊŜ ŀ ŦŜǿ ǉǳŜǎǘƛƻƴǎ ȅƻǳ Ƴŀȅ ǿŀƴǘ ǘƻ ŎƻƴǎƛŘŜǊ ǿƘŜƴ ǎŜƭŜŎǘƛƴƎ ǘƘŜ άǊƛƎƘǘέ Template: 

Á Who is my audience? 

Á Whŀǘ ǘȅǇŜǎ ƻŦ ǎȅƳōƻƭǎ ƻǊ ƎǊŀǇƘƛŎǎ ǿƛƭƭ άǎǇŜŀƪέ ǘƻ Ƴȅ ŀǳŘƛŜƴŎŜΚ 

Á Should the information be quantitative or qualitative, or both?  

Á In what format will the final Diagram be delivered?   

Á Will it be printed, displayed online, emailed, part of a presentation or a combination?  

Á Have you seen similar types of information presented before? What type of format was used? 

 

 

 

Figure 3. The Popular Category gives you access to the most commonly used Template 
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LŦ ȅƻǳΩǊŜ ǎǘƛƭƭ ƴƻǘ ǉǳƛǘŜ ǎǳǊŜΣ ǿŜ ǊŜŎƻƳƳŜƴŘ ǘƘŀǘ ȅƻǳ ǎǘŀǊǘ ƛƴ ǘƘŜ tƻǇǳƭŀǊ /ŀǘŜƎƻǊȅΦ  IŜǊŜ ȅƻǳΩƭƭ ŦƛƴŘ ǘƘŜ 

most commonly used SmartDraw Templates.   

 

²ŜΩǊŜ ƎƻƛƴƎ ǘƻ ǳǎŜ ǘƘŜ CƭƻǿŎƘŀǊǘ Template.  There are two paths to navigate to Flowcharts.  You can 

either select Flowcharts in the Popular Templates Preview Area of the screen or you can navigate to 

Flowcharts in the Left Panel.  Regardless of which option you select, you are brought to the same screen. 

 

 

 

Figure 4. Each Category not only contains Template but Examples from which you can build from 

 

In the Template Preview Area, you are given three Flowchart Template options: basic Flowchart, 

Swimlane - Landscape, or Swimlane - tƻǊǘǊŀƛǘ ƭŀȅƻǳǘΦ  Wǳǎǘ ōŜƭƻǿ ǘƘŀǘ ȅƻǳΩƭƭ ŦƛƴŘ Flowchart Examples in 

other words sample Diagrams of the selected Template.  
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HOW TO ACCESS AN EXAMPLE TEMPLATE  

Step Action 

1 Navigate to the Home Screen.  In the Left Panel, select the appropriate Category. 

2 In the Left Panel, select the appropriate Sub-Category. 

3 In the Template Preview Area, select the appropriate Example thumbnail. 

 

Note: The example will appear on the screen. To return to the previous screen, simply 
close the example. 

 

The Examples or sample Diagrams are a great way to get started on your next Diagram.  Samples can 

inspire you or simply give you an idea of how to use that particular Template.   Simply select a Diagram, 

ŦƻǊ ŜȄŀƳǇƭŜ ǘƘŜ άIƛǊƛƴƎ tǊƻŎŜǎǎΦέ   !ƴ ŜŘƛǘŀōƭŜ ǾŜǊǎƛƻƴ ƻŦ ǘƘŜ ǎŀƳǇƭe then appears on screen.   

 

If you want to return to the previous screen, simply close the Diagram.  There are a number of 

ǎǳōŦƻƭŘŜǊǎ ƻŦ CƭƻǿŎƘŀǊǘǎ ŦƻǳƴŘ ƛƴ ǘƘŜ [ŜŦǘ tŀƴŜƭ ŦƻǊ ȅƻǳ ǘƻ ŎƘƻƻǎŜ ŦǊƻƳ ŀǎ ǿŜƭƭΦ  ²ŜΩƭƭ ƪŜŜǇ ǘƘƛƴƎǎ 

simple and select the basic Flowchart Template.   
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A TOUR OF THE SMARTDRAW USER INTERFACE 

bƻǿΣ ǿŜΩǊŜ ǊŜŀŘȅ ǘƻ ǘŀƪŜ ŀ ƭƻƻƪ ŀǘ {ƳŀǊǘ5ǊŀǿΩǎ ¦ǎŜǊ LƴǘŜǊŦŀŎŜΦ  ¢ƘŜǊŜ ŀǊŜ three basic regions: the 

Ribbon, the SmartPanel, and the Work Area. 

 

 

Figure 5. Three Regions of the SmartDraw User Interface 

 

TITLE BAR 

The Ribbon has a number of components.  The first is the Title Bar.  It displays the file name of the 

Diagram that is being edited and the name of the software. It also includes the standard Minimize, 

Restore, and Close controls to the right. 
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QUICK ACCESS TOOLBAR 

To the left, we find what is referred to as the Quick Access Toolbar.  Frequently used commands include: 

Undo, Redo, New, Save, and Print. In addition, you also have other commonly used commands to send 

your Diagram ǘƻ 9ƳŀƛƭΧ ƻǊ ǉǳƛŎƪƭȅ ŜȄǇƻǊǘ ƛǘ ǘƻ t5CΣ ²ƻǊŘΣ tƻǿŜǊtƻƛƴǘΣ ŀƴŘ 9ȄŎŜƭΦ  ¢Ƙƛǎ ŎƻƳŜǎ ƛƴ ƘŀƴŘȅ 

when sharing your Diagrams with others. 

 

THE RIBBON & TABS 

The Ribbon contains all of the controls you need to design and tailor your Diagram.  It is divided into a 

set of tabs which sort the controls based on their function. Keep in mind that the Ribbon is consistent 

from one Template ǘƻ ǘƘŜ ƴŜȄǘΦ {ƻ ǿƘŜǘƘŜǊ ȅƻǳΩǊŜ ǳǎƛƴƎ ǘƘŜ aƛƴŘ Map to brainstorm during your next 

team meeting or organizing your next event with Project Planning, the functionality found in the Ribbon 

remains the same.   

 

 

Figure 6. The Ribbon 
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THE SMARTPANEL 

In contrast to the Ribbon, each Template has its own unique SmartPanel, with controls specialized to 

building that particular DiagramΦ ¢ƘŜ {ƳŀǊǘtŀƴŜƭ ƛǎ άǎƳŀǊǘέ ƛƴ ǘƘŀǘ ƛǘ ƎƛǾŜǎ ȅƻǳ ŀŎŎŜǎǎ ǘƻ ǘƘŜ ǘƻƻƭǎ ȅƻǳ 

need to make that specific Diagram with ease. 

 

SmartPanels, such as that of Flowcharts shown here, employ Automatic Shape Connectors, which means 

you will not only add a symbol, but it will also be connected to another symbol already in the Work Area, 

with perfect spacing and placement. This feature gives you the ability to build your Diagrams very 

quickly and easily. 

 

IŜǊŜΩǎ ŀƴ ƛƴǎƛŘŜǊ ǘƛǇΥ Ƴŀƴȅ ƻŦ ǘƘŜ controls found in the SmartPanel have help text. If you hover over a 

particular control it will provide you with a brief description. And as an added bonus, it will also display 

the keyboard shortcut, if one applies.  In this case, if we hover over Add Right, it indicates that the 

keyboard shortcut is the Ctrl key on the keyboard plus the Right arrow key.  

  

 

 

Figure 7. The SmartPanel contains features and functionality directly related to the Template 
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THE SYMBOLS 

Located in the tab immediately to the right of the SmartPanel tab is the Symbols tab.  It contains more 

than 34,000 professionally designed symbols, images and clip art.  When you select a particular 

TemplateΣ ȅƻǳΩƭƭ ŦƛƴŘ ǘhat SmartDraw will display the symbol library specialized to building that 

particular DiagramΦ   LŦ ǘƘŜ ƻŦŦŜǊŜŘ ƭƛōǊŀǊȅ ŘƻŜǎƴΩǘ ƘŀǾŜ ǘƘŜ ǎȅƳōƻƭ you want to add, simply click More to 

display the More Symbols window.  Enter the appropriate criteria in the search field. 

 

 

Figure 8. You have access to over 5,000 professional designed symbols from any of the SmartDraw Templates 
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HOW TO SEARCH FOR SYMBOLS 

Step Action 

1 In the SmartPanel, click More. In the More drop-down menu, select More. . . 

2 In the More Symbols dialogue box, enter the appropriate search criteria.  

3 Click Enter key or the magnifying glass. 

HOW TO OPEN A NEW SYMBOL LIBRARY 

Step Action 

1 In the Search Results, select the appropriate library. Confirm and review library in the 
review area of the More Symbols dialogue box. 

2 Click OK. 

 

Note: The new symbol library will appear in the SmartPanel and the More Symbols 
dialogue box will automatically close.  

 

CƻǊ ŜȄŀƳǇƭŜΣ ƛŦ ǿŜ ŜƴǘŜǊ άǾŀƭǳŜ ǎǘǊŜŀƳέ ŀƴŘ ŎƭƛŎƪ {ŜŀǊŎƘΧΦ ǿŜΩƭƭ ŦƛƴŘ ǘƘŜ ǎȅƳōƻƭǎ ǳǎŜŘ ŦƻǊ ±ŀƭǳŜ {ǘǊŜŀƳ 

Mapping.  If this is the library we want to use, simply click OK.   When you look to the left in the 

SmartPanel, the title Value Stream Mapping appears at the top.  Now, you can easily click and drag 

ǎȅƳōƻƭǎ ƛƴǘƻ ǘƘŜ ²ƻǊƪ !ǊŜŀΦ  hƴŎŜ ǿŜΩǾŜ ƎŀǘƘŜǊŜŘ ǘƘŜ ǎȅƳōƻƭǎ ǿŜ ƴŜŜŘΣ ǊŜǘǳǊƴ ǘƻ ǘƘŜ ƻǊƛƎƛƴŀƭ ƭƛōǊŀǊȅ 

by navigating to the Library Selector menu and select Flowchart.   

 

L Ŏŀƴ ŎƘƻƻǎŜ ǘƻ ǎŎǊƻƭƭ ǘƘǊƻǳƎƘ ǘƘŜ ǎȅƳōƻƭǎ ƻǊ ŦƻǊ ŜŀǎŜ ƻŦ ǳǎŜΣ LΩƭƭ ŎƭƛŎƪ the Symbols tab. Now, I can easily 

click and drag symbols into my Work Area as neededΦ  hƴŎŜ LΩǾŜ ƎŀǘƘŜǊŜŘ ǘƘŜ ǎȅƳōƻƭǎ L ƴŜŜŘΣ L Ŏŀƴ 

return to the original library by navigating to the More drop-down menu and select Flowchart.  And if I 

ǿŀƴǘ ǘƻ ŀŎŎŜǎǎ ŀƴȅ ǎȅƳōƻƭ ƭƛōǊŀǊȅ ǘƘŀǘ L ƘŀǾŜ ǊŜŎŜƴǘƭȅ ǳǎŜŘ LΩŘ ǎƛƳǇƭȅ ǊŜǘǳǊƴ ǘƻ ǘƘŜ More drop-down 

menu. 

HOW TO RETURN TO A RECENT SYMBOLS LIBRARY 

Step Action 

1 Navigate to the SmartPanel.  Click the More drop-down arrow. 

 

Note: The Library Selector Menu drop-down menu will display. 

2 In the More drop-down menu, select the appropriate recent library.  
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THE WORK AREA 

²ŜΩǾŜ ŎƻǾŜǊŜŘ ǘƘŜ ōŀǎƛŎǎ ƻŦ ǘƘŜ wƛōōƻƴ ŀƴŘ ǘƘŜ {ƳŀǊǘtŀƴŜƭΦ  bƻǿ ƭŜǘΩǎ ƳƻǾŜ ƻƴǘƻ ǘƘŜ third region . . . 

the Work Area.   

 

 

Figure 9. The Work Area is where you will build your Diagram 

 

Your Diagram will be built in the Work Area. As you add more symbols to it, the Work Area will 

automatically grow to make room. Although the Work Area looks like a single page, you will be able to 

split the Work Area into multiple pages prior to printing your Diagram. This is something you should 

keep in mind, since a large Diagram printed on one page may have to be decreased in size so much that 

it becomes illegible.   

 

CƻǊ ŜȄŀƳǇƭŜΣ ƛŦ ȅƻǳ ŘŜŎƛŘŜ ǘƻ ŎǊŜŀǘŜ ȅƻǳǊ ŦŀƳƛƭȅ ǘǊŜŜ ƻǊ ȅƻǳǊ ŘŜǇŀǊǘƳŜƴǘΩǎ ƻǊƎ ŎƘŀǊǘ ƛǘ ǿƛƭƭ ŀǇǇŜŀǊ to fit 

ƻƴ ƻƴŜ ǇŀƎŜ ŀǎ ȅƻǳ ŎǊŜŀǘŜ ƛǘ ƛƴ {ƳŀǊǘ5ǊŀǿΦ  LŦ ȅƻǳΩǊŜ ǇƭŀƴƴƛƴƎ ǘƻ ǇǊŜǎŜƴǘ ƛǘ ŦǊƻƳ ǿƛǘƘƛƴ {ƳŀǊǘ5ǊŀǿΣ ƛǘ 

can easily be viewed in its entirety.  However, if the final format of the Diagram ƛǎ ǘƻ ōŜ ǇǊƛƴǘŜŘΣ ȅƻǳΩƭƭ 

have to update the print settings or use a printer that prints on larger paper. 
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 SAVING A DIAGRAM 

bƻǿ ǿŜΩǊŜ ƎƻƛƴƎ ǘƻ ǎǿƛǘŎƘ ƎŜŀǊǎ ŀƴŘ ƛƳŀƎƛƴŜ ǘƘŀǘ ȅƻǳ Ƨǳǎǘ ŦƛƴƛǎƘŜŘ ŎǊŜŀǘƛƴƎ ŀ Diagram.  You must save 

your Diagram so you can quit the program without losing your work. When you save, it is stored as an 

.sdr file.  

HOW TO SAVE A DIAGRAM 

Step Action 

1 There are several options to save a Diagram: 

2a Navigate to the Quick Access Toolbar. Click Save. 

 

Note: The Save control is to just above the Home Tab. 

2b Navigate to the File Tab. 

In the File Menu, click Save (to save an existing file) 

OR 

In the File Menu, click Save As (to save a new file) 

2c Use Ctrl key (Cmd for mac) on your keyboard + S key (to save an existing file) 

3 Enter the appropriate name in the File name: field.  Click Save. 

 

Note: The Title Bar changes to reflect the new name of the file. 
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SAVING A DIAGRAM AS A PDF 

We recognize that you may wish to share your Diagram with people who may or may not own a copy of 

SmartDraw. For this reason, we make it easy for you to save your Diagram as a PDF, which is readable by 

programs like Adobe Acrobat®.   

 

 

 

Figure 100. When you save a Diagram as a PDF you have the option to include the hyperlinks to the file 

HOW TO SAVE A DIAGRAM AS A PDF 

Step Action 

1 Navigate to the Quick Access Toolbar. Click PDF. 

 

Note: The red PDF control is to just above the Design and Insert Tabs. 

2 In the PDF Export dialogue box, click OK. 

 

Note: The Print on One Page setting is defaulted.  If your Diagram is a linked Diagram, 
in other words linked to other Diagrams, you may choose to select the Include Links to 
Files check box. 

3 The Adobe Reader will open the PDF into a separate window. 

http://www.smartdraw.com/


 

19 www.smartdraw.com 1-858-225-3300 © 2016 SmartDraw Software, LLC. All rights reserved. 

 

SMARTDRAW USER GUIDE: Fundamentals for New Users 

 OPENING & CLOSING A RECENT DIAGRAM  

OPENING A RECENT DIAGRAM 

[ŜǘΩǎ ǎŀȅ ǘƘŀǘ ȅƻǳΩŘ ƭƛƪŜ ǘƻ ǊŜǘǳǊƴ ǘƻ ƻƴŜ ƻŦ ǘƘŜ Diagrams you started working on earlier. Any saved files 

you have created or opened with SmartDraw will appear in the Template Preview. Simply click on the 

thumbnail of the Diagram you would like to revisit.   

 

 

 

Figure 111. Easily access your Diagrams from the Home ScreenΩǎ wŜŎŜƴǘ ŦƻƭŘŜǊ 
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HOW TO OPEN A RECENT DIAGRAM 

Step Action 

1 In the Left Panel, navigate to Recent. 

2 In the Template Preview, select the appropriate diagram thumbnail. 

 

CLOSING A DIAGRAM 

To close a Diagram and select a new Template simply use the Close Visual control.  You are immediately 

brought back to the Home Screen.   

 

HOW TO CLOSE A DIAGRAM 

Step Action 

1 Navigate to the top right-hand corner of the Work Area. 

2 Click Close Visual. 

 

Note: The Close Visual control ƛǎ ǘƘŜ ōƭŀŎƪ άȄέ ƭƻŎŀǘŜŘ ǘƻ ǘƘŜ ǊƛƎƘǘ ƻŦ ǘƘŜ IŜƭǇ control. 

 

CLOSING SMARTDRAW 

CƻǊ ŎƻƴǾŜƴƛŜƴŎŜΣ ǿŜ ǊŜŎƻƳƳŜƴŘ ƻǇŜƴƛƴƎ {ƳŀǊǘ5Ǌŀǿ ŀǎ ǇŀǊǘ ƻŦ ȅƻǳǊ Řŀƛƭȅ ǊƻǳǘƛƴŜΦ  LŦ ȅƻǳΩǊŜ ƴƻǘ 

currently using it, simply minimize it as you would with your email ŀŎŎƻǳƴǘΦ  ²ƘŜƴ ȅƻǳ ƴŜŜŘ ƛǘ ƛǘΩǎ ŀ 

matter of one-click to opening it up.  Yet, there may be a case in which you wish to close the program.   

 

HOW TO CLOSE SMARTDRAW 

Step Action 

1 Navigate to the top right-hand corner of the application. 

2 In the Title Bar, click Close SmartDraw. 

 

Note: The Close SmartDraw control is the white άXέ ƭƻŎŀǘŜŘ to the right of the 
Maximize/Restore control. 
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ADDING TEXT, COLOR, AND EFFECTS 

LǘΩǎ ƴƻǿ ǘƛƳŜ ǘƻ ǘŀƪŜ ŀ ŎƭƻǎŜǊ ƭƻƻƪ ƛƴǘƻ Ƙƻǿ ǘƻ ŎǊŜŀǘŜ 5ƛŀƎǊŀƳǎΦ  YŜŜǇ ƛƴ ƳƛƴŘ ǘƘŀǘ ǘƘƛǎ SmartDraw 

fundamentals course does not cover the in-depth features and functionality of each of the 70 categories 

of Templates found in SmartDraw. However, it will cover some of the basic tools and techniques that 

apply to all of the Templates in order to get you up and running. 

 

ADDING TEXT TO SYMBOLS 

Although we all know that a picture is worth a thousand words, we recognize that you may need to add 

text to your Diagrams.  aƻǊŜ ǎǇŜŎƛŦƛŎŀƭƭȅΣ ǿŜΩǊŜ ƎƻƛƴƎ ǘƻ ǘŀƪŜ a look at techniques of not only adding 

text to symbols, but to lines as well.   

 

 

Figure 122. Adding Text to Symbols is quite easy, simply use the Tab key to navigate from one to the next as you 

enter text 

 

HOW TO ADD TEXT TO SYMBOLS 

Step Action 

1 Navigate to the appropriate symbol. 

2 Double-click on the symbol.  Enter the appropriate text. 

3 Click Esc key or somewhere else in the Work Area. 

 

Text is added inside most symbols, but for some, such as symbols related to engineering, the text is 

added below the symbols instead.  

 

If you are adding text to a series of symbols, for example in a Flowchart, you can press the Tab key to 

quickly move from symbol to symbol, speeding up the process. As you continue to add text, the symbol 

is automatically resized to accommodate the text. 
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ADDING TEXT TO LINES 

Depending on the type of Diagram ȅƻǳΩǊŜ ŎǊŜŀǘƛƴƎ, you may need to add text to lines.  This includes 

Automatic Shape Connectors as well.    

HOW TO ADD TEXT TO LINES 

Step Action 

1 Navigate to the appropriate line. 

2 Double-click on the line.  Enter the appropriate text. 

3 Click Esc key or somewhere else in the Work Area. 

 

 

 

Figure 133. Simply double click on the line and begin typing  
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ADDING FREE-FLOATING TEXT 

When designing a Diagram, the title provides the viewer or audience with context of what they are 

viewing.  In this case, you will be adding what is referred to as Free-Floating Text. 

 

HOW TO ADD FREE-FLOATING TEXT 

Step Action 

1 Navigate to the Ribbon.  Click once the Text control. 

 

Note: ¢ƘŜ ƭŜǘǘŜǊ ά!έ ƛǎ ǘƘŜ ¢ŜȄǘ control. 

2 Navigate to the Work Area. Click once and enter the appropriate text. 

3 Click Esc key.  Click and drag the text box to the appropriate location. 

 

Be mindful where you click, because if you click on an item in the Work Area, you will add text to that 

item instead of creating a new text box. If you want to add a text box which you can manually position 

over an item (giving you greater control over where text inside an item lies), add the text to a blank 

place in the Work Area, then drag the text box into place.  By default, the text box you add has no fill or 

border. However, you can treat this text box just like any other shape: you can color it, resize it, move it, 

rotate it, attach lines to it, and so on.   
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ADDING COLOR AND STYLE  

Color and style can bring a Diagram to life.  LŦ ƛǘΩǎ ŀ Diagram for a client, it can be branded with their 

corporate colors.  If ȅƻǳΩŘ ƭƛƪŜ to highlight your findings ŦǊƻƳ ǘƘŜ ǊŜǎŜŀǊŎƘ ȅƻǳΩǾŜ ŘƻƴŜ and want to 

make a statement, the results can be emphasized through the use of color and texture.  Giving your 

findings the attention it deserves.  SmartDraw makes adding color to your Diagram as easy as building it. 

 

APPLYING THEMES 

You can change the entire color scheme of the Diagram with a single click through the use of Themes. 

Themes provide a professional, color-coordinated appearance to the entire Diagram.  For example, if 

you want to brand a Diagram with your cƻǊǇƻǊŀǘŜ ŎƻƭƻǊǎ ƻǊ ǘƘƻǎŜ ƻŦ ȅƻǳǊ ŎƭƛŜƴǘΩǎ ƛǘ ǿƻǳƭŘ ƻƴƭȅ ōŜ ŀ 

matter of a few clicks.  

 

 

Figure 144. Themes Control enables you to apply a set color scheme to your Diagram 

HOW TO APPLY A THEME TO A DIAGRAM 

Step Action 

1 In the Home tab, click Themes. 

2 In the Themes menu, select the appropriate theme. 

However, if you manually color an item in the Work Area and then change the theme, the colors will be 

overridden so that they match the new theme that has been selected. Instead, we would recommend 

that you color items using Styles. 
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APPLYING QUICK STYLES 

By using Styles, you can apply a fill color, line color and style, text font, color, and size to selected items 

in the Work Area. The colors offered in the Styles menu are determined by the selected theme. When 

you change themes, the colors change to match the theme, but all other styling remains the same. 

 

 

Figure 155. The Styles options are determined by the Theme that has been selected 

 

HOW TO APPLY QUICK STYLES TO A DIAGRAM 

Step Action 

1 In the Work Area, select the symbol ǘƻ ǿƘƛŎƘ ȅƻǳΩŘ ƭƛƪŜ ǘƻ ŀǇǇƭȅ ǘƘŜ {ǘȅƭŜΦ 

 

Note: To select multiple symbols or items, hold down the Shift key and click on the 
items to select them. 

2 In the Home tab, click Styles. 

3 In the Styles menu, select the appropriate option. 

 

Note: The colors and style will instantly apply to the Diagram. 
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CHANGING THE FILL OF A SYMBOL 

If you find that the Themes that are available in SmartDraw do not meet your needs you have the option 

to manually change the fill of a shape.  Manually changing the color of specific shapes in your Diagram 

will draw the attention of your viewer or audience. You can also choose a gradient, texture, or hatch, 

and you can set the transparency of the fill.  Color can emphasize or de-emphasize the information that 

is being conveyed.   

 

However, if you are going to work with themes, make sure you choose a theme and do not change it 

again before applying any fill colors. This is because changing the theme will automatically override the 

fill color.  

 

 

 

Figure 166. Fill enables you to apply not only color but gradient, texture, hatch as well as set the level of 

transparency 
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HOW TO CHANGE THE FILL OF A SYMBOL 

Step Action 

1 In the Work Area, select the appropriate symbol.  

2 In the Home tab, click Fill. 

3 In the Fill menu, select the appropriate option. 

 

MODIFYING LINES  

In addition to applying color to shapes, you can change the color and style of the border of shapes or of 

lines using the Line control. Like fill colors, line and border colors are overridden by a change in themes.  

²ƛǘƘ ǘƘŀǘ ǎŀƛŘΣ ƛǘΩǎ ƛƳǇƻǊǘŀƴǘ ǘƻ ƳŀƪŜ ǎǳǊŜ ȅƻǳ ŀǊŜ ǎŀǘƛǎŦƛŜŘ ǿƛǘƘ ǘƘŜ ǎŜƭŜŎǘŜŘ ǘƘŜƳŜ ōŜŦƻǊŜ ŀǇǇƭȅƛƴƎ 

line and border colors using the Line control.  

 

 

Figure 177. Determine the color, style, and thickness of the lines within the Diagram 
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